




















































































































































































































































































































































































































































































Creating 
Word 
Documents 
with Excel 
Data 

A common pairing of Office 
programs combines Word 
and Excel. As you write a 
sales report, explain a 
budget, or create a memo 
showing distribution of 
sales, you'll often want to 
add worksheet data and 
charts to your text. instead of 
re-creating the Excel data in 
Word, you can insert aJJ or 
part of the data or chart into 
your Word document. 

Insert an Excel 
Worksheet Range into a 
Word Document 

G) Click in the Word document 
where you want to copy the 

range. 

0 Click the Insert menu, and 
then click File. 

0 Click the pop-up menu, 
and then select the drive 
and folder that contains the 
workbook you want to copy. 

0 If necessary, click the List 
Files Of Type pop-up menu, 
and then select Readable 
Files. 

0 Click the filename of the 
workbook you want to copy. 

@ Click Insert. 

0 Click the Open Document 
In Workbook pop-up menu, 
and then select the 
workbook you want. 

(!) Click the Name Or Cell 
Range pop-up menu, and 
select the range you want 
to copy. 

@clickOK. 
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Import Excel data as a 
picture. To save disk space, 
you can insert Excel data as a 
picture. Data inserted this way 
becomes a table that you cannot 
edit .. Select tile data you wanl to 
import, press the Shift key as 
you click tile Edit menu, and 
then click Copy Picture. In the 
Copy Picture dialog box, click 
OK. Click in the Word 
document where you want to 
insert the picture, and then click 
the Paste button on Lhe 
Standard tool/Jar. Dms the 
picture borders until it's ea:;y to 
read. 

TRY THIS 

Create a new Excel 
worksheet directly In 
Word document. With the 
insertion point where you want 
tile worksheet, click Lhe Jnse1t 
MS Excel Worksheet button on 
the Standard too/bar, drag to 
select the number of rows and 
columns you want, type the 
data and format the worksheet 
as needed, and then click 
outside tl1e worksheet to retum 
to the Word window. When you 
save the file, the worksheet 
becomes em/Jedded in the 
Word document. 

Embed an Excel Chart 
in Word 

G) Open the Excel workbook 
that contains the chart you 
want to use. 

0 Click the Excel chart you 
want to embed to select it. 

0 Click the Copy button on 
the Standard toolbar. 

0 Click in the Word document 
where you want to embed 
the chart. 

@ Click the Paste button on 
the Standard toolbar. 

0 
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Creating a 
Power Point 
Presentation 
with Word 
Text 

PowerPoint presentations are 
based on outlines, which 
you can create either using 
PowerPoint or the more 
extensive outlining tools in 
Word. You can import any 
Word document into 
PowerPoint, although only 
paragraphs tagged with 
heading styles become part of 
the slides. You can also copy 
any table you created in 
Word to a slide. 

SEE ALSO 

See "Applying a Style" on page 
95 and "Creating and 
Modifying a Style" on page 96 
for more infonnation about 
using heading styles in Word. 

Create PowerPoint 
Slides from a Word 
Document 

0 Create a Word docum~nt 
with heading styles, and 
then close the Word 
document. 

0 In PowerPoint, click the 
Open button on the 
Standard toolbar. 

0 Click the List Files Of Type 
pop-up menu, and then 
select All Outlines. 

0 Click the pop-up menu, 
and then locate the Word 
file you want to use. 

0 Double-click the Word 
document filename. 

Embed a Word 
Table in a Slide 

0 Click in the Word table you 
want to use in a slide. 

0 Click the Table menu, and 
then click Select Table. 

0 Click the Copy button on 
the Word Standard toolbar. 
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Headings In Word become 
t itles in PowerPoint. Each 
Heading 1 style in a Word 
docum ent becomes the title of a 
separate slide in Powerl'oint. 
Heading 2 becom es the first 
level of indented text and so on. 
/(a document contains no 
styles, l'owerPoint uses t11e 
paragraph indents to detennine 
a slide structure. 

Create 35mm slides using 
Genigraphics. Using the 
Value Pack illstaller, install 
Genigrap/1ics. Open tile 
presentation from which you 
want to create 35mm slides, 
click the File menu, point to 
Sellll To, d ick Genigraphics, 
and then follow the 
instructions. 

0 Display t he PowerPoint 
slide where you want to 
insert the Word table. 

0 Click the Paste button on 
the PowerPoint Standard 
tool bar. 

0 Drag a handle to resize the 
embedded table. 

0 Double-click the table to 
display Word's menus and 
toolbars, and edit the table 
using the usual Word 
commands. 

Create a Word 
Document from 
a Powe rPoint 
Presentation 

(!) Open the PowerPoint 
presentation you want to 
use as a Word document. 

0 Click the File menu, point 
to Send To, and then click 
Microsoft Word. 

Word sta rts and opens the 
p resentation as a Word 
document. 

0 Edit the text using the usual 
Word commands. 
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Sending Files 
in E-Mail 
Messages 

When you want others to 
receive a copy of an Office 98 
file, you can send the file 
through e-mail. You can also 
route a file through e-mail, 
rather than send it, when 
you want others to review a 
copy of it online. You can 
send the file to one recipient 
after another, so that each 
recipient can see the previ­
ous revisions, or to all 
recipients at once. 1\s the file 
is routed, you can track its 
status. After all of the 
recipients have reviewed the 
fi le, it is automatically 
returned to you. 

Send a File to Others In 
an E-mail Message 
(D Open the file you want to 

send. 

0 Click the File menu, point 
to Send To, and then select 
Mail Recipient. If necessary, 
click OK. 

Your default e-mail 
prog ram (such as Microsoft 
Outlook Express) opens, 
displaying a new e-mail 
message window with an 
attached file. 

0 Click in the To box, and 
then enter an e-mail 
address. 

0 Click in the Subject box, 
and then enter the subje<;:t 
text. 

0 Click in the message box, 
and then enter message 
text. 

You can format the text like 
you would any other text. 

@ Click Send on the toolbar. 
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Reading and 
Replying to 
E-Mail 
Messages 

Mail can be sent to you at 
anytime. Before you can 
retrieve your e-mail, you 
need to connect to the 
Internet. Once you are 
connected, you can send and 
receive e-mail. New messages 
appea r in the lnbox along 
with any messages you 
haven't yet stored elsewhere 
or deleted. Unread messages 
appear in bold text, while 
previously read messages 
appear in normal text. Once 
you have read a message, you 
can reply to the author and 
other recipients. 

Mail button 

Divert Incoming e -mail to 
folders. Click tile Tools menu, 
click lnbox Rules, click New 
Rule, set criteria (or incomi11g 
mcs.mses, a11d tllen click OK. 

Open and Read a 
Message 
0 Double-click the Mail icon 

on the desktop and connect 
to the Internet. 

0 Click the Send & Receive 
button on lhe tool bar. 

0 Click lnbox in the folder list. 

0 Click a message to display 
it in the Preview pane, or 
double-click a message to 
open it up in its own 
window. 

Reply to a Message 
0 Open the message you 

want to reply to. 

0 Click the Reply or Reply All 
button on the toolbar. 

0 Type your message and 
attach any files you want to 
send. 

0 Click the Send button on 
the toolbar, or click the File 
menu, and then click Send 
Later. 

Welcome to your one·stop source for all of your 
mcsSilQinQ needs: 

• E-mail accounts 

~me Edit VI..,., A.1enaue rorm•t Tools Wln~ow llelp 9:39PM • ~ 

~ OurJouk IXpreu 

w f1 f!S 1:1~1\ 0 l!J ~ @ @I II .... .. ,., ..... "" hr .. n ....,tof.t..d c .. w. ... r~ ... u . .. ....... ~. bc:thof flr?l"~ 

[J Ae:WelcomP to OUUook Express ~ E!IB 

'Gl a • I In ..... ·~ Md Alt4idmtttts St1Nt1A"O CCitltKb 

~1: 
l r~~t ('Sin•~> :1 PrleJitt dNorm•l I : I ~ 

-outlook ~•n Tt.wn• (msm.toot~ncf'ouft .com• 

.. jool. Itt" . Y t lconw to Oltlook [ XVKS . 
, s:,:, I f'tonMI : I 1 s11 r Jt ui E J[:~ r:o:ll ~: II~~ II 

Outlook Express Teom, 0 
Thanks for developmg e greet product 

~ 

Steve 
----------
rrom ·outlook Express Teom· <msmecoeomlcrosoft conn 
To ·New Out tool( Express user· . 
Sublet t. Welcome to Outlook Express 

..... ), 1d~;.11!11M 

SIIARING INFORMATION BETWEEN 01'FICE 98 P ROGRAMS 233 



Managing 
E-Mail 
Messages 
One problem that can arise 
as you receive e-mail is an 
overabundance of messages 
in your In box. To help you 
manage your mail messages, 
Outlook Express provides a 
way to delete messages, and 
move messages to other 
folders and subfolders. 
Storing messages in other 
folders and deleting un­
wanted messages make it 
easier to see the new mes­
sages you receive. You can 
move a message into another 
folder quickly and easily: 
simply, drag the message to 
the folder you want in the 
folder list. 

You can also add and edit 
contact information, includ­
ing names and e-mail 
addresses to keep the 
informatin current. 

Add a new folder to the 
folder list. Click tile File 
menu, point to New, anrl tl1e11 
click Folder or Sub(o/rler. 

Delete Unwanted 
E-Mail Messages 
G) In Outlook Express, click the 

folder containing the 
messages you want to 
delete. 

0 Select the message(s) you 
want to delete. 

0 Click the Delete button on 
the toolbar. 

0 Click Deleted Messages in 
the folder list. · 

0 Click the Edit menu, and 
then click Empty Deleted 
Messages. 

Add or Edit a Contact 
to the Address Book 
G) In Oulook Express, click 

Contacts in the folder list. 

0 To add a contact, click New 
on the Standard toolbar. 

0 To edit a contact, select the 
contact you want to edit, 
and then click Edit on the 
Standard toolbar. 

0 Enter or edit the contact 
information. 

0 Click Save. 

@ Click the Close box. 
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SPECIAL 
CHARACTERS 

' (apostrophe), numeric label 
prefix (worksheets), 126 

.. (arrowhead symbol), menu 
symbol, 22 

* (asterisk), multiplication 
operator, 140 

: (colon), range reference 
character, 130 

:#€: key (Command key), 23 
deleting words, 34 
setting line spacing, 85 
undoing/redoing actions, 34 

... (ellipsis), menu/dialog box 
symbol, 22, 23 

- (em clash), entering, 32 
= (equal sign), formula prefix, 

140 
- (minus sign), subtraction 

operator, 140 
+ (plus sign) 

addition operator, 140 
in pointer box, 29 

I (slash), division operator, 140 

0 
absolute cell references (in Excel 

worksheets), 141 

Accept Or Reject Changes dialog 
box (Excel), 163 

action buttons, 203 
cl icking, 214 
creating, 214, 215 
inserting in slides, 215 
testing, 2 14 
See also hyperlinks 

Action Settings dialog box 
(Powerl'oint), 215 

aclions, undoing/redoing, 
34, 71 

active cell (in worksheets/ 
datasheets), 124, 207 

Add Data dialog box (Excel), 
adding data series, 1 53 

Add Report dialog box (Excel), 
179 

Add Scenario dialog box (Excel), 
178 

addition operator (+), 140 
address book (in Outlook 

Express), adding/editing 
contacts, 234 

addresses 
local documents, 52 
postal, formatting, 104 
Web pages, 53, 62 
worksheet cells, 124 

Advanced Search , fi ndi ng 
files, 11 

Align Left button (Alignment 
toolbar), 148 

Align Right button (Alignment 
toolbar), 148 

aligning 
data in Excel worksheets, 148 
objects, 39 
tables in Word dol:uments, 

117 
text in Word documents, 84, 

106 
in columns, 122 
in headers/ footers, 106, 

107 
within table cells, 118-1 9 

Alignment buttons (Formalling 
toolbar), 106 

Alignment toolbar (Excel), 
buttons, 148 

animating 
bulleted lists, 212, 2B 
Graph charts, 212 
text, 83, 212, 213 

animations (in l'owerl'oin t), 203 
adding sound to, 213 
adding to slides, 212-13 
previewing, 212 
removing, 213 

annotations, adding to Excel 
charts, 155 

apostrophe ('), numeric label 
prefix (worksheets), 126 

applications. See Office 
programs 

Index 
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arithmetic operators, 140 
order of precedence, 141 

arrowhead symbol ( .. ), menu 
symbol, 22 

arrows, styling, 39 
asterisk (*), multiplication 

operator, 140 
auditing Excel worksheets, 177 
AutoCalculate, calculating 

with, 144 
i\utoComplete 

enabling for cell values, 127 
entering worksheet cell labels 

with, 126, 127 
finding Internet addresses 

with, 62 
i\utoContent Wizard 

(Power Point) 
creating presentations, 185 

for the Web, 59 
AutoCorrect 

adding entries to, 33 
correcting spelling while 

typing, 32, 76 
creating exceptions to, 33 
reversing changes made 

by, 33 
AutoFill (Excel), fi lling in data 

in worksheets, 144 
AutoFilter (Excel), filtering 

records in Excel lists, 145, 
158 

AutoFit (Word), adjusting table 
column widths, 11 7 

AutoFormat (Excel), fo rmatting 
worksheet text and 
numbers, 147 

AutoLayout placeholders 
(PowerPoint), 191 

AutoLayouts (in PowerPoint), 
applying to slides, 190, 
191 

AutoText (in Word), inserting, 
109 

AVERAGE function (Excel), 143 

Background dialog box 
(PowerPoint), 198 

background objects (on 
PowerPoint masters), 
hiding on slides, 198 

backup copies, saving, 13 
balloon help, 14 
barcodes, l'OSTNET, printing 

on envelopes, 104 
blank files, creating, 9 
boldface, applying in Word, 82 
bookmarks (in Word), 

inserting, 4 7 
borders 

adding to pictures, 43 
adding to tables in Word 

118,120 • 
adding to text in Word, 120 
adding to worksheet cells, 

149 
Break dialog box (Word), 

inserting page/section 
breaks, 94 

brochures, creating, 41, 120, 121 
Browse Arrow buttons (Word 

window), 67 
Browse button (Word 

window), 67 
Browse toolbar (Word), 67 
browsing Word documents, 67 
bulleted lists 

animating, 212, 213 
creating 

in PowerPoint, 193 
in Word, 98 

creating slides from, 193 
restyling in Word, 99 

Bullets And Numbering dialog 
box (Word), 99 
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buttons 
column/row indicator 

buttons (in Excel 
worksheets), 136 

option buttons (in dialog 
boxes), 22 

scroll buttons (for 
worksheets), 125 

view buttons, 64, 65, 187 
See also action buttons; 

toolbar buttons; and 
specific buttons 

G 
calculating 

with Excel functions, 143 
using AutoCalculate, 144 

capitalization, correcting, 32, 76 
case, matching in Word 

searches, 74 
cell contents (data) 

in Excel worksheets 
aligning, 148 
analyzing, 145, 156-64 
auditing, 177 
consolidating from 

worksheets/ 
workbooks, 174-75 

creating/showing 
scenarios of, 178 

creating Word docu-
ments with, 228-29 

editing, 128 
entering, 126-27 
filling in automatically, 

144 
importing as pictures, 229 
protecting, 164 
summarizing, 145, 160-61 

in Graph datasheets, 
entering, 207 

in Word tables 

deleting, 113 
entering, 112, 113 

cell formats (in Excel 
worksheets), copying, 
147 

Cell Height And Width dialog 
box (Word), 11 7 

cell references (in Excel 
worksheets), 124 

absolute, 141 
entering in formulas, 140 

cells 
in Excel worksheets, 124 

acti ve cell, 124 
adding borders to, 149 
addresses, 124, 140 
auditing, 177 
clearing, 129 
copying, 176 
copying cell formats, 147 
deleting, 129 
entering text and 

numbers into, 
126-27 

inserting, 129 
linking, 165, 176 
removing arrows from, 

177 
selecting multiple, 130-31 
See also cell contents 

(data), in Excel 
worksheets; cell 
references; ranges 

in Graph datasheets, 206 
active cell, 207 
entering data into, 207 

in Word tables 
aligning text within, 

118-19 
changing text direction 

within, 119 
clearing, 113 
entering text into, 112, 

113 



cells continued 
merging, 116 
selecting, 113 
splitting, 116 

Center button (Alignment 
toolbar), 148 

centering text, 84 
character spacing (in Word 

documents), changing, 
83,99 

chan1cters 
deleting, 34 
non prin ti ng characters in 

Word documents, 
66,87 

resizing in worksheet 
prin touts, 139 

See also specia l characters 
chart area (in Graph), 209 
chart boxes (Organization 

Chart), fo rmatting, 44 
chart objects, 154, 206 

cldding to Excel ch arts, 
154-55 

selecling/forma tting in 
Graph, 209 

Ch art Options dialog box 
(Excel), 154, 155 

Ch art Type dialog box (Graph), 
208 

Chart Wizard (Excel), creating 
charts, 150-51 

charts 
in Excel, 150-55, 206 

adding gridlines, 154, 155 
adding legends, 154 
adding text annotations, 

154, 155 
adding tilles, 154 
adding trendlines, 153 
changing types, 155 
creating, 1 50-51 
as embedded objects, 151 

embedding in Word 
documents, 229 

formatting elements, 155 
in Graph, 206 

animating, 212 
crealing, 206-9 
creating a chart type, 208 
entering data into 

datasheets, 207 
formalling chart objects, 

209 
inserting in slides, 206 
selecting a chart type, 208 
selecting chart objects, 

209 
check boxes, in dialog boxes, 

22,23 
clearing worksheet cells, 129 
clip art 

adding to every slide in a 
presentation, 198 

cropping, 42, 43 
inserting, 42 

Clip Gallery, inserting clip art 
from, 42 

Clipboard, copying/moving 
text with, 2R, 72 

closing files , 19 
collapse box (windows), 18 
colon (:), range reference 

character, 130 
Color Scheme dialog box 

(PowerPoinl), ZOO 
color schemes (PowerPoint) 

applying to slides, 200-201 
choosing, ZOO 
customizing, 200 
de le ling, 200 

colo ring 
objects, 39, 42, 43 
slides, 200-20"1 
text, 82 

colo rs 
types, 43 

See also color schem es 
(PowerPo in t); coloring 

column letters (in Excel 
worksheets), printing, 139 

column titles (in Excel 
worksheets), print ing, 139 

columns 
in Excel worksheets 

freezing/unfreezing, 167 
inserting, 136 

in Word 
align ing text in, 122 
creating/modifying, 122 
viewing side by side, 122 

in Word tables 
adj usti ng widths, 115, 

11 7 
deleting, 114, 11 5 
distributing evenly, 115 
inserting, 114 
moving, 115 
selecti ng, 11 3 
sorting the entries in, 119 
summing, 119 

Columns dialog box (Word), 
122 

Command key. See ~ key 
comment codes (in Word 

documents), displaying, 
110 

comments 
hiding/displaying, 35 
inserting, 35 
reviewing, 35 

comments (in Word docu-
ments) 

browsing, 67 
deleting, 110 
insert ing, 110 
reading, 110 

Confirm Password dialog box 
(Excel), 164 

Consolidate dialog box (Excel), 
174 

consolidat ing data from 
worksheets/workbooks, 
174-75 

contacts (in Outlook Express), 
adding/edit ing, 234 

converting, text to Word tables, 
112 

copying 
cells in worksheets, 176 
formulas in worksheets, 141 
styles in Word, 95 
text, 28-29 

in Word, 68, 72-73 
worksheets, 134, 135 

COUNT function (Excel), 143 
Create Data Source dia log box 

(Word), 101 
Crop tool (Picture toolbar), 42 
cwpping images, 42, 41 
curves, d rawing, 38 
Custom Animat ion dialog box 

(PowerPoint), 2 13 
Custom Sh ows dialog box 

(PowerPoin t), 216 
Custom ize dialog box, custom­

izing toolbars, 25 
cutting text, 28 

data. See cell contents (data); 
data series; entering; 
exporti ng; importing; 
inserting; lists 

data analysis (in Excel), 156-64 
tools, 145 

data files (for mail merges) 
creating, 100-101 
merging with main docu­

men ts, 102-3 
selecti ng existing, 100 

Data Form dialog box 
(Word), 101 
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Data Forms (Excel), 145, 168 
adding records using, 168 
managing records using, 169 

data points (in Excel), 152 
deleting single points, 153 

data ranges. See ranges (in Excel 
worksheets) 

data series, 152, 206 
adding/deleting in Excel, 

152, 153 
changing in Excel, 153 

databases. See lists, in Excel 
datasheets (in Graph), 206 

entering data into, 207 
dates, inserting (in Word), 108 
Decrease Indent button 

(Formatting toolbar), 
88,89 

Define Custom Show di.alog 
box (PowerPoint), 216, 
217 

Delete dialog box (Excel), 129 
Delete key, deleting characters/ 

words, 34 
deleting 

animations, 213 
characters, 34 
color schemes (in 

PowerPoint), 200 
columns/rows (in Word 

tables), 11 4, 11 5 
comments (in Word 

documents), 110 
data series, 152, 153 
e-mail messages, 234 
favorite documents, 58 
hyperlinks, 49 
records in Excel lists, 168 
slide shows, 217 
slides, 191, 195 
text, 66 
typing errors, 34 
WordArt, 41 
words, 34 

worksheet cells, 129 
worksheets, 132, 133 

deletions, restoring, 71, 153 
desktop 

creating files from, 9 
opening existing files 

from , 10 
sta rting Office programs . 

from, 8 
desktop publishing effects, 

adding to text in Word, 
120-2 1 

destination files, 220, 221, 224 
subscribers, 221, 226 

destination programs, 221 
dialog boxes, 22 

choosing options, 22-23 
navigating, 23 
See also wizards; and specific 

dialog boxes 
division operator (/), 140 
docking floating toolbars, 24 
Document dialog box, 91, 107 
tlocumcnt elements, find ing 

and replacing, 31 
document windows, 18, 21 

in Excel, 124 
in l'owerl'oint, 187 
in Word, 64, 66 
See also windows 

tlocuments 
adding to favorites, 58 
addresses, 52 
closing, 19 
creating, 9 

as Web pages, 59 
with wizards, 27 

finding, 11 
inserting comments in, 35 
inserting hyperlinks in/ 

between,46,47 
jumping to favorites, 58 
opening, 10-1 1 
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recently used 
opening, 10 
setting the number of, 

166 
saving, 12-13 

wiU1 another name, 12 
backup copies, 13 
in different folders, 13 
in different formats, 13, 

60-61 
for the first time, 12 
as HTML documents, 

60-61 
selecting, 23 
See also h yperlinked 

documents; Web 
documents; Word 
documents 

drag and drop 
copying/moving text, 29, 

72-73 
installing Microsoft Office, 

6-7 
drawing 

lines and shapes, 38 
tables in Word documents, 

112 
Drawing toolbar, manipulating 

objects, 39 
drop caps, adding to text in 

Word, 121 

0 
e-mail messages 

deleting, 234 
diverting to folders, 233 
managing, 234 
reading, 233 
replying to, 233 
sending files in, 232 

Edit 1-lyperlink dialog box, 49 

Edit Text button (WordArt 
toolbar), 41 

Edit WordArt Text dialog 
box,40 

editing 
custom slide shows, 21 7 
embedded objects, 224, 225 
favorite documents, 58 
linked objects, 224, 225 
objects, 38, 39 
organization charts, 44 
records in Excel lists, 169 
te.xt, 28-29 

in Word, 63, 67-79 
worksheet cell contents, 128 

editions 
publishing and subscribing 

to, 221,226 
update options, 227 

ellipsis ( ... ), menu/dialog box 
symbol, 22, 23 

em dash (- ), entering, 32 
email messages. See e-mail 

messages 
embedded objects 

changing Linked objects to, 
224 

charts as, 151 
editing, 224, 225 
embedding 
Excel charts/worksheets in 

Word documents, 229 
objects, 220, 224 
Word tables in slides, 230-31 

end mark (Word window), 64 
enhancing objetts, 38, 39 
Enter button (formula bar), 

entering worksheet cell 
labels, 126 

entering 
cell references in formulas, 

140 
data into Graph datasheets, 

207 



entering continued 
fo rmulas into Excel 

worksheets, 140 
fractions, 32 
funct ions into Excel 

worksheets, 143 
records into Excel lists, 15 7 
superscript ordinals, 32 
text 

into Excel worksheet cells, 
126-27, 157 . 

into l'owerl'oint outlines, 
194 

into PowerPoin t place­
holders, 191, 192-93 

into Word documents, 66 
into Word tables, 112, 113 

See also inserting 
envelope codes, printing, 104 
envelopes, addressing and 

printing in Word, 104 
Envelopes And J.ahels dialog box, 

104 
equal sign (=), formula prefix, 

140 
Excel (Microsoft), 123-82 

calculations, 143, 144 
customizing, 166 
data analysis tools, 145 
print options, 138-39 
program window. See Excel 

wi ndow 
See also workbooks (in Excel); 

worksheets (in Excel); 
and under charts; lists 

Excel window, 124 
elements, 124, 125, 126, 128 
splitting into panes, 167 

exiting Office programs, 20 
expand box (windows), 18 
exporting 

fi les, 220, 222, 223 
information, 223 

0 
r keys, displaying named ranges, 

142 
favorite documents 

adding/deleting, 58 
editing, 58 
jumping to, 58 

Favorites button (Web 
toolbar), 58 

favorites folder, adding files 
to, 58 

field names 
in Excel lists, I 56, 15 7 
in Word data files, 101 

inserting in main docu­
ments, 102 

fields 
in Excel lists, 156, 158 

index fields, 159 
sorting records on, 15!l-59 

in Word data files, 101 
files 

adding to favorites, 58 
d osing, 19 
creating, 9 
destination fi les, 220-21, 224 
exporting, 220, 222, 223 
finding, 11 
importing, 220, 222 
jumping to favorites, 58 
opening, 10-11 
recently used 

opening, 10 
setting the number of, 166 

saving, 12-B 
wi th another name, 12 
backup copies, 13 
in different folders, 13 
in d ifferent formats, 13, 

60-61 
for the first time, 12 
as HTML documents, 60 

as templates (in Word), 92 
sending in e-mail messages, 

232 
source files, 220-2 1, 224 
See also documents 

fill handle (Excel) 
copying formulas, 141 
filling in data, 144 

filtering records, in Excel lists, 
145, 158 

flM-A codes, prin ting on 
envelopes, 104 

Find And Replace dialog box, 31 
Find And Replace dialog box 

(Word), 74, 75 
Find dialog box, 30 
finding 

files, 11 
information on the Web, 56 
In ternet addresses, 62 
text, 30, 31 

in Word, 74 
text formaning in Word, 74 
See also replacing 

flipping objects, 39 
floating toolbars, ducking, 24 
folders 

adding new, 234 
default, 166 
diverting e-mail messages to, 

233 
Favorites fo lder, 58 
saving files in diffe ren t folders, 

13 
selecting, 23 
Templates folder, 93 

font a ttributes (in Excel 
worksheets), applying, 146 

Font dialog box (Word), 83 
fonts 

in Excel worksheets, 
specifying, 166 

in Word documents 

animation effects, 83 
character spadng, 83 
specifyi ng, 82 

foo ters 
in Excel worksheets, printing, 

139 
in slides, adding/changing, 

204 
in Word documents, 106 

aligning, 106, 107 
creating, 106-7 
setting margins for, 91 

form letters 
creating, 100-101 
merging with data, 102-3 
printing, 103 

Format AutoShape dialog 
box, 37 

Format Cells dialog box (Excel) 
add ing borders to cells, 149 
al igning data, 148 
formatting numbers, 147 
formatting text, 146 

Format Data Series dialog hox 
(Graph), 209 

Formal Pain ter 
applying Powerl'oint color 

schemes, 201 
copying Word document 

styles, 95 
copying worksheet cell 

fo rmats, 14 7 
format WordArt button 

(WordArt toolbar), 41 
formatt ing 

chart objects in Graph, 209 
documents in HTML, 60-6 1 
numbers in Excel worksheets, 

146-47 
organization chart boxes, 44 
postal addresses, 104 
tables in Word, 118-19 

I NDEX 239 



formatting continued 
text 

in Excel worksheets, 146, 
147 

with find and replace, 31, 
74-75 

while typing, 83 
in Word documents, 66, 

74-75, 81-104 
See also text formatting 

formatti ng toolbar, 24, 64 
Alignment buttons, 106 
indenting text, 88, 89 

formula bar (Excel window), 124 
editing cell contents, 128 

formula prefix (=), 140 
formulas (in Excel worksheets), 

140 
auditing, 177 
cell changes and, 129 
copying, 141 
displaying, 141 
entering, 140 
entering cell references in, 140 
using ranges/range names in, 

142 
See also functions (in Excel) 

fractions, entering, 32 
frames (of Web pages), 61 
Free Rotate button (Wordi\rt 

toolbar), 41 
freezing/unfreezing columns/ 

rows in Excel worksheets, 
167 

function keys. See F keys 
functions (in Excel worksheets), 

143 
calculating with, 143 
entering, 143 

Genigraphics, installing, 231 

GIF format, 61 
grammar, correcting in Word, 

76-77 
Graph (Microsoft), 206 

See also under charts 
graphic formats, types, 61 
graphic objects. See objects 
graphs. See charts 
gridlines 

in Excel charts, 154 
adding, 154, 155 
major versus minor, 155 
printing worksheets with, 

139, 149 
in Word tables, displaying/ 

hiding, 119 
grouping objects, 39 

handles, selection handles, 36 
Handout Master, formatting, 

205 
handouts, adding to presenta­

tions, 205 
Header And Footer toolbar 

(Word), 106, 107 
buttons, 108 

headers 
in Excel worksheets, printing, 

139 
in slides, adding/changin g, 

204 
in Word documents, 106 

aligning, 106, 107 
creating, 106-7 
setting margins for, 91 

headings (in Word documents), 
as converted in 
PowerPoint, 231 

Help, 14-17 
balloon help, 14 
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getting information on 
particular topics, 14, 15 

Office Assistant, 16-17, 124, 
160 

hiding 
background objects on slides, 

198 
grid lines, in tables in Word 

documents, 119 
Office programs, 20 
rulers (in Word), 86 
ScreenTips, 25 
slides in slide shows, 189 
toolbars, 24, SO 

Highlight Changes dialog box 
(Excel), 162 

highlighting (in Word docu­
ments), applying, 82, 83, 
111 

HTML (Hypertext Markup 
Language), 60 

HTML ·documents, saving Office 
documents as, 60-61 

Hyperlink To Slide dialog box 
(Powerl'oint), 215 

hyperlinked documents 
address list, 54 
favorites, 58 
jumping to, 45, 52, 53, 54, 58 
navigating, 45, 54-55 
reloading, 55 
See also hyper links; Web 

documents 
hyperlinks, 45, 48, 221 

adding to slides, 215 
clicking, 48 
inserting, 46-47 
removing, 49 
renaming, 49 
stopping, 55 
See also action buttons 

Hypertext Markup Language. See 
HTML 

hyphenating Word 
documents, 78 

0 
importing 

Excel data as pictures, 229 
files, 220, 222 
See also inserting 

Increase Indent button (Format­
ting toolbar), 88, 89 

indenting 
paragraphs 

in PowerPoint, 195 
in Word, 88 

tables in Word documents, 
117 

index fields (in Excel), protecting 
list order with, 159 

information 
exporting, 223 
gelling Help on particular 

topics, 14, 15 
getting information about 

the Web, 15 
searching for information on 

Lhe Web, 56 
sharing information between 

Office programs, 
219-34 

Insert Date button (Header And 
Footer toolbar), 108 

Insert dialog box (Excel), 129 
Insert File dialog box (Word), 

222,228 
Insert Hyperlink dialog box, 

46-47 
Insert Number Of Pages button 

(Header And Footer 
tool bar), 108 

Insert Outline dialog box 
(PowerPoint), 195 



Insert Page Number button 
(Header And Footer 
toolbar), 108 

Insert Time button (Header And 
Footer toolbar), 108 

Insert WordArt button (WordArt 
toolbar), 41 

inserting 
action buttons in slides, 215 
AutoText, 109 
bookmarks, 47 
clip art, 42 
columns 

into Word tables, 114 
into worksheets, 136 

comments, 35, 11 0 
dates (in Word), 1 OR 
f.xcel ranges into Word 

documents, 228 
Graph charts in slides, 206 
hyperlinks, 46-4 7 
outlines into PowerPoint, 194, 

195 
page breaks 

into Word documents, 94 
into worksheets, 137 

page numbers (in Word), 1 OR 
pictures, 42 
rows 

into Excel worksheets, 136 
into Word tables, 114 

section breaks into Word 
documents, 94 

slides, 190 
from other presentations, 

191 
special characters, 32, 109 
times (in Word), 108 
worksheet cells, 129 
worksheets, 1 :n, I :B 
See also embedding; entering; 

importing; linking 
insertion poin t 

on PowerPoint slides, 192 

in Word documents, 63, 66 
installing 

Genigraphics, 231 
Microsoft Office, 6-7 
Report Manager (Excel), 179 

Internet. See Web 
Internet addresses, 53 

finding, 62 
Internet Assistant Wiza.rd, 

creating HTML docu­
ments, 60-61 

intranets, formatting documents 
for, 60-61 

italics, applying in Word, 82 

0 
J PEG format, 61 
jumping 

to favorite documents, 58 
to hyperlinked documents, 

45,52,53,54,58 
to slides, 215 
to start page, 51 

justifying text, 84 

keyboard shortcuts. See shortcut 
keys 

0 
labels 

mailing labels, addressing and 
printing, 104 

in worksheet cells 
entering, 126-27, 157 
formatting, 146, 147 
long, 127 

legends, adding to/deleting from 
Excel charts, 154 

Less button (Word Find And 
Replace dialog box), 75 

letterheads, creating, 26 
line arrows, styling, 39 
lines 

d.rawing, 38 
styling, 39 

lines of text 
indenting, 88, 193 
selecting, 71 
spacing, 85 

linked objects 
changing to embedded 

objects, 224 
editing, 224, 225 

linking 
cells in Excel worksheets, 165, 

176 
h yperlinking, 221 
objects, 220-21, 224, 225 

li nks 
between worksheets, creating/ 

breaking, J 76 
See also hyperlinks 

list boxes, in dialog boxes, 22 
list ranges (in Excel lists), 156 

entering information in, 
168 

lists 
in Excel 

creating, 15 7 
filtering records, 145, 158 
finding data in, 168 
PickList, 157 
protecting list order, 159 
sorting records, 145, 

158-59 
summarizing data, 145, 

160-61 
terminology, 156 

numbered lists, 98-99 
See also bulletcd lists 

Locator dialog box (Excel), 168 
logos 

adding to every slide in a 
presentation, 198 

creating, 39 

Macro dialog box, 180, 1 R2 
macros (in Excel), 180 

debugging, 180 
recording, 180, 181 , 182 
running, 180, 182 
versus templates, 171 

Mail Merge Ilelper (Word), 100 
mail merges (in Word), 100-103 

error checking before starting, 
103 

sending to printers, 103 
mailing labels, addressing and 

printing, 104 
main documents (for mail 

merges) 
creating, 100,102 
merging data files with, 102-3 
selecting, 100 

margins (in Word documents), 
setting, 70, 90-91 

masters (in PowerPoint) 
adding/changing headers and 

footers, 204 
design ing slides with, 19R-99 
fo rmatting the Handout/ 

Notes Master, 205 
overriding, 199 
reapplying, 199 
Title Master versus Sl ide 

Master, 198 
Max (Office Assistant), 16 
MAX function (Excel), 143 
media clips 

inserting, 42 
See also clip art; pictures 

menu bars, in Office program 
windows, 64, 124, 187 
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menu commands 
choosing, 22 
versus shortcut keys, 23 

menus, 22 
Merge And Cer)ter button 

(Alignment toolbar), 148 
merging 

cells in Word tables, 116 
form letters with data, 102-3 
workbooks, 175 

messages, "[Shared)" status 
message in title bars, 163, 
173 

Microsoft Excel. See Excel 
(Microsoft) 

Microsoft Graph. See Graph 
(Microsoft) 

Microsoft In ternet Explorer, 6 
Microsoft Internet solutions, 6 

installing, 7 
Microsoft Office. See Office 

(Microsoft) 
Microsoft Office 98 Macintosh 

Edition Jlt a Glance, 1-3 
Microsoft Office programs. See 

Office programs 
Microsoft Outlook Express, 6 

adding/editing contacts, 234 
Microsoft PowerPoint. See 

Powerl'oint (Microsoft) 
Microsoft Word. See Word 

(Microsoft) 
MIN hmction (Excel), 143 
minus sign(-), subtraction 

operator, 140 
mirror margins (in Word 

documents), setting, 91 
Modify Style dialog box 

(Word), 97 
More button (Word Find and 

Replace dialog box), 75 
mouse pointer 

copying text in Word, 73 

displaying shortcut 
menus, 22 

in the Excel window, 124 
getting balloon help, 14 
plus sign in pointer box, 29 
presenting slide shows, 218 
resizing and moving 

windows, 18 
selecting objects, 36 
in the Word window, 64 

Move Or Copy dialog box 
(Excel), moving 
worksheets, 135 

moving 
objects, 36, 39 
rows/columns, in Word 

tables, 11 5 
slides, 197 
text, 28-29 

in Word, 68, 72-73 
toolbars, 24 
windows, 18 
worksheets, 134, 135 
See also jumping; navigating; 

rearranging 
multiple cells (in Excel 

worksheets), selecting, 
130-31 

multiple windows, 
arranging, 18 

multiplication operator(*), 140 

name box (Excel window), 124 
named ranges (in Excel 

worksheets) 
going to, 131 
selecting, 131 

names 
displaying toolbar button 

names, 24, 64 
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field names in Excel lists, 156, 
157 

range names in formulas, 
142 

naming 
hyperlinks, 49 
worksheet ranges, 131 
worksheets, 132, 133 

navigating 
dialog boxes, 23 
hyperlinked documents, 45, 

54-55 
slide shows, 218 
Word documents, 67 
Word tables, 112, 113 
workbooks/worksheets, 125 
See also jumping 

New command, creating files, 9 
New dialog hox, creating files, 

9,26 
New dialog box (Word), 93 
New Presentation dialog box 

(PowerPoint), 184, 186 
New Slide dialog box 

(PowerPoint), 190 
New Style dialog box 

(Word), 96 
newsletters, creating, 41 , 120, 

121 
newspaper columns. See 

colun1ns, in Word 
nonprinting characters (in 

Word documents), 66, 87 
Normal template (Word), 92 
notes 

adding annotations to Excel 
d1arts, 155 

adding to presentations, 
189, 205 

Notes Master, formatting, 205 
Notes Page view (PowerPoint), 

189 
numbered lists 

creating in Word, 98 

restyling in Word, 99 
numbers 

entering into worksheets, 
126-27 

formatting in worksheets, 
146-47 

numeric formats (in Excel 
worksheets), applying, 
146-47 

numeric label prefix (worksheets) 
('), 126 

Object dialog box, embedding 
objects, 224 

Object Linking and Embedding 
(OLE), 220-21 

objects, 36, 37 
adding 3-D effects to, 39 
adding shadows to, 39 
adding to documents, 39 
adding to every slide in a 

presentation, 198 
aligning, 39 
chart objects, 154-55, 206, 209 
coloring, 39, 42, 43 
drawing, 38 
embedding, 220, 224 
enhancing, 38, 39 
flipping, 39 
grouping, 39 
inserting, 42 
linking, 220-21, 224, 225 
moving, 36, 39 
resizing, 37 
rotating, 39 
scaling, 37 
selecting, 36 
WordArt, 40-4 l 
See also clip art; pictures 

Office (Microsoft), installing/ 
uninstalling, 6-7 



Office Assistant, 16, 124 
choosing an Assistant, 17 
customizing, 17 
getting help from, 16-17, 160 
installing more Assistants, 17 
tips, 17 

Office Manager 
installing, 8 
starting Office programs 

from, 8 
Office programs, 5, 21 

creating files from within, 9 
hiding, 20 
quitting, 20 
self- repairing, 7 
shared tools, 2 1-44 
sharin g information 

between, 219-34 
starting, 8 
Sec also Excel; Power Point; 

Word 
OLE (Object Linking and 

· Embedding), 220-21 
onli ne Help. See Help 
Open dialog box, finding 

fi les, 11 
Open Worksheet dialog box, 

228 
o pening 

documents 
existing, I 0- 1 I 
new Excel workbooks, 

171 
new Word documents, 66 
recently used, 10 

templates, 170 
Web documents, .'i3 
Web pages, 52 

option buttons (i n dialog 
boxes), 22 

o rder of precedence of arith­
metic operations, 141 

o rgan ization charts, creating/ 
formatting/styling/ 
editing, 44 

Outline view (PowerPoint), 188 
Sec also outlines, PowerPoint 

outlines 
nonPowerPoint, inserting into 

PowerPo int, 194, 19.'i 
PowerPoin t, 194 

adding slides to, 194 
collapsing/expanding 

slides, 196, 197 
entering text into, 194 
indenting text, 195 
printing, 202 
rearranging slides, 196, 197 
selecting slides, 197 
showing/h id ing text 

formatting, 19.'i 
Outlook Express (Microsoft), 6 

adding/editing contacts, 234 

0 
page breaks 

inserting/deleting in Excel, 137 
inse rting/deleting in Word, 94 
previewing/moving in Excel, 

137 
page numbers, inserting in Word, 

108 
page orientation, specifying in 

Word, 70 
page setup, Word documents, 70 
Page Setup dialog box 

j.>rint options in Excel, 139 
print options in Word, 70, 90, 

107 
Page Setup dialog box 

(Word), 70 
pages 

creating headers/footers for 
specific pages (in 
Word), 107 

page/section breaks (in 
Word), 94 

shrinking Word documents to 
fit, 79 

See also page setup; start page 
panes (in the Excel window) 

freezing/unfreezing, 167 
splitting the Excel window 

into, 167 
paper size, specifying in Word, 70 
Paragraph dialog box (Word) 

indenting paragraphs, 89 
line/paragraph spacing, 85, 89 

paragraphs 
in PowerPoint 

indenting, 195 
spacing, 193 

in Word 
beginning new, 66 
indenting, 88 
selecting, 71 
setting tabs, R7 
spacing, 85 

password protection (in Excel), 
164 

Past Functio n button (Standard 
toolbar), 143 

Paste Name dialog box (Excel), 
142 

Pick List (in Excel), entering labels, 
157 

pictures 
adding borders to, 43 
animating, 212 
browsing in Word, 67 
cropping, 42, 43 
importing Excel data as, 229 
inserting, 42 

l'ivotTable Wizard (Excel), 
creating PivotTabl(;!s, 160 

PivotTables (in Excel), 145, 
160-61 

c reating, 160 
creating charts from, 161 

placeholders (in PowerPo int) 
creating, 191 

entering text into, 191, 192, 
193 

plot area (in Graph), 209 
plus sign ( +) 

add ition operator, 140 
in poin ter box, 29 

PMT functio n (Excel), 143 
pointer box, plus sign in, 29 
points (text size units), 37 
POSTN ET barcodes, printing on 

envelopes, 104 
PowerPoi nt (Microsoft), 

18~-218 

masters, 198-99 
program window elements, 

187 
views, 188-89 
See also presentations; slide 

shows; slides 
PowcrPoint dialog box 

(PowerPoint), 184 
PowerPoint window, 187 

elements, 187 
precedence of arithm(;! tiC 

opera tions, 141 
Preferences dialog box (Excel), 

displaying formulas, 141 
Preferences dialog box 

(PowerPoint), General 
tau, 166 

Preferences dialog box (Word), 
spelling and grammar 
preferences, 76 

presentation window 
(l'owerPoint), 187 

presentations (in PowerPo int), 
183-218 

add ing notes/handouts to, 
189,205 

applying color schemes 
between,201 

applying templates to, 186 
creating, 183-202 
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presentations (in PowerPoint) 
continued 

designing, 203-14 
inserting slides from other 

presentations, 191 
printing, 202 
running slide shows, 189 
saving as HTML 

doruments, 61 
sharing, 183 
starting, 184 
switching between, 184 
with the AutoContent 

Wizard, 59, 185 
with templates, 186 
as Web pages, 59 
from Word documents, 

230-31 
creating Word documents 

from, 231 
See also slide shows; slides 

preview boxes, in dialog boxes, 
22,23 

previewing 
animations, 212 
Word documents, 70, 79 
worksheets, 138 

print area (in Excel worksheets), 
limiting, 139 

Print dialog box, in l'owerl'oint, 
202 

print options 
in Excel, 138-39 
in Word, 70, 80 

Print Preview toolbar 
(Word), 79 

printing 
envelopes, 104 
form letters, 103 
mailing labels, 104 
outlines (in PowerPoint), 202 
presentations, 202 
slide shows, 217 

slides, 202 
Word documents, 80 
worksheets, 138-39, 149 

program windows 
opening existing files 

from, 10 
See also Excel window; 

PowerPoint window; 
windows; Word 
window 

programs. See Office programs 
Protect Sheet dialog box (E~Ccel ), 

164 
protecting data (in Excel 

worksheets), 164 
publishers, 221, 226 

canceling, 227 
publishing editions, 221, 226 

quitting Ofrice programs, 20 

0 
range names (in Excel . 

worksheets), in formulas, 
142 

ranges (in Excel worksheets), 
130-31 

calculating, 144 
in formulas, 142 
inserting into Word 

documents, 228 
list ranges, 156, 157 
named/ naming, 131 
references, 130 
selecting, 130, 131 

for charting, ISO 
reading e-mail messages, 233 
rearranging 

rows/columns (in Word 
tables), 11 5 
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slides, 188-89, 196-97, 217 
See also moving 

Record Macro dialog box, 181 
recording 

Excel macros, 181 
sounds, 211 

records (in Excel lists), 156 
adding, 168 
deleting, 168 
editing, 169 
entering, 157, 168 
Ciltering, 145, 158 
managing, 169 
sorting, 145, 158-59 

Redo button, 34 
redoing actions, 34, 71 
renaming hyperlinks, 49 
replacing 

text, 30, 31 
while typing, 32 
in Word, 74-75 

text formatting, 74, 75 
replying to e-mail messages, 233 
Report Manager (Excel), install­

ing, 179 
reports (from Excel worksheets), 

creating, 179 
resizing 

characters in worksheet 
printouts, 139 

objects, 37 
windows, 18 

Return action button, 2 15 
Return key 

entering worksheet cell labels, 
126 

specifying cell selection after 
pressing, 166 

Reviewing toolbar, reviewing 
comments, 35 

reviewing work, using 
comments, 35 

rotating objects, 39 

row numbers (in Excel 
worksheets), printing, 139 

row titles (in Excel worksheets), 
printing, 139 

rows 
in Excel lists, sorting data in, 

159 
in Excel worksheets 

freezing/unfreezing, 167 
inserting, 136 

in Word tables 
adjusting heights, 115, 117 
deleting, 114, 115 
distributingevenly, 115 
inserting, 114 
moving, 115 
selecting, 113 

rulers (in Word) 
indenting text, 88 
setting margins, 90 
showing/hiding, 86 

0 
Save As command (File 

menu), 12 
Save As dialog box 

exporting files, 223 
saving documents as 

templates, 92 
Save As HTML dialog box, 61 
Save command (File menu), 12 
saving documents, 12-13 

with another name, 12 
backup copies, 13 
in different folders, 13 
in different formats, 13 
for the first time, 12 
as HTML documents, 60-61 
as templates (in Word), 92 

scaling objects, 3 7 
Scenario Manager (Excel), 178 
Scenario Values dialog box 

(Excel), 178 



scenarios (of Excel worksheet 
da ta) 

creating and showing, 178 
creating reports of, 179 

ScreenTips (toolbars) 
displaying, 24 
hiding, 25 

scroll a rrows, 67 
scroll boxes, 67, 125, 188 
scroll buttons (for worksheets), 

125 
scrolling 

Word documents, 67 
worksheets, 125 

Search dialog box, find ing 
files, 11 

search engines, 56 
search page, sett ing, 56, 57 
searching. Sec finding 
section breaks, inserting/deleting 

in Word, 94 
sectio ns (of Word 

documents), 94 
Select Changes To Accept Or 

Reject dialog box (Excel), 
163 

selected text, deleting, 34 
selecting 

chart objects (in Graph), 209 
objects, 36 
slides, 197 
table elements (in Word), 113 
text, 71 
worksheet ranges, 130, 131 

selection handles, 36 
sending files in e-mail messages, 

232 
shading 

adding to tables in Word, 
118, 120 

adding to text in Wo rd, 120 
shadows, adding to objects, 39 
shapes, drawing, 38 

Share Workbook dialog box 
(Excel), 172 

"[Sha red]" status message in title 
bars, 163, 173 

sharing Excel workbooks 
changing options, 172-73 
enabling, 172 

sheet tabs (Excel window), 124, 
132 

Shift key, outdenting text, 193 
shortcut keys, 23 

neating, 109 
deleting typing errors, 34 
set ti ng line spacing, 85 
undoing/redo ing actions, 34 
versus menu commands, 23 
See also Com mand key; f 

keys; Shift key 
shortcut menus, 22 
Shortcut Menus toolbar, 

adding, 2S 
Show/llide bullo n (Standard 

toolbar), 110 
slash (/), division operator, 140 
slide icons, 188, 189 
Slide Layout d ialog box 

(PowerPoint), 190 
Slide Master, versus Ti t le Master, 

198 
slide numbering, changing, 20S 
Slide Show view (PowerPoin t), 

189 
slide shows 

creating custom, 2 16, 217 
editing custom, 217 
hiding slides in, 189 
navigation controls, 218 
presen ting, 218 
prin ting custom , 217 
removing custom, 217 
showing, 189, 2 16, 218 
See also presentations (in 

Power Point) 

Slide Sorter view, viewing slide 
transit ions, 2 1 I 

Slide Sorter view (PowerPoint), 
188-89 

rearranging slides, 188-89, 196 
Slide Transition dialog box 

(Powerl'oint), 210, 211 
slide transitions, 203 

adding, 189 
adding sound to, 211 
applying to all slides, 210 
setting t ransition effect speeds 

and timing, 211 
specifying, 210 
viewing, 211 

Slide view (l'owerPoint), 188 
enteri ng text in, 19 1, 192-93 
indenting text in, 195 

slides 
adding animations, 212-13 
adding/changing headers and 

footers, 204 
adding hyperli nks to, 215 
adding to outlines, 194 
adding to slide shows, 217 
applying changes to all, 199 
applying color schemes to, 

200-201 
collapsing/expanding in 

Outline view, 196, 197 
creating, 190-91 

from bulleted lists, 193 
from Word documents, 

230-3 1 
deleting, 19 1, 195 

from slide shows, 217 
designing 

with Autolayouts, 190 
with masters, 198-99 

duplicating, 195 
embedding Word tables, 

230-3 1 
hiding, in slide shows, 189 

hiding background objects 
on, 198 

icons, 188, 189 
inserting, 190 

from other presentations, 
191 

inserting action buttons, 215 
inserting Graph charts, 206 
jumping to, 215 
moving, 197 
moving through, 188 
numbering, 205 
in Oulline view, 188 
printing, 202 
rearranging, 188-89, 196-97, 

217 
selecting, 197 
viewing miniatures, 188, 199 
See also slide shows; slide 

transitions 
Sort dialog box (Excel), 159 
sorting records, in Excel lists, 

145, 158-59 
sounds 

adding to animations, 213 
adding to slide transitions, 

211 
recording, 211 

Source Data dialog box (Excel), 
153 

source fi les, 220, 221, 224 
publishers, 221,226 

source programs, 221, 224 
speaker notes, adding to 

presentatio ns, 189, 20S 
special characters 

finding and replacing, 3 1 
inserting, 32, 109 
wildcard search characters, 

74, 75 
See also Special Chamclcrs 

sect ion of I 11 is i ndcx 
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spelling, correcting 
undoing/redoing 

corrections, 34 
while typing, 32, 76 
in Word, 76-77 

Spelling and Grammar dialog 
box (Word), 77 

spin boxes, in dialog boxes, 
22, 23 

splitting cells in Word tables, 116 
splitting windows (in Word), 69 
stacked fractions, entering, 32 
Standard toolbar, 24, 64 

Past Function button, 143 
Show/Hide button, 110 

Start menu, opening existing files 
from, 10 

start page 
jumping to, 51 
setting, SO, 51 

starting, presentations (in 
PowerPoint), 184 

starting Office programs, 8 
status hars, in Office program 

windows, 64, 124, 187 
Style dialog box (Word), 96 
Style Ga llery (Word), 93 
Sty le li st box (Word), applying 

styles with, 95 
styles (in Word), 81, 95-97 

applying, 95 
creating, 96, 97 
modifying, 97 

subscribers, 221, 226 
canceling, 227 

subscribing to editions, 221, 226 
subtraction operator (-), 140 
SUM function (Excel), 143 
summarizing Word documents, 

111 
superscript ordinals, entering, 32 
symbols. See special characters 

0 
tab characters, displaying in 

Word, 87 
Tab key 

indenting text, 88, 193 
navigating dialog boxes, 23 
navigating tables, 11 2, 11 3 

tab stops, setting/clearing in 
Word, 87 

Table AutoFormat dialog box 
(Word), 118 

Table of Contents, locating 
information with, 14 

tables. See PivotTables (in Excel); 
tables (in Word docu­
ments); worksheets (in 
Excel) 

tables, in Word documents, 
embedding in slides, 230-31 

tables (in Word documents), 112 
adding borders/shading, 118, 

120 
browsi ng, 67 
converting tex t to, 11 2 
creating, 112 
deleting cell contents, 113 
d isplaying/hiding gridlines, 

11 9 
drawing custom, 112 
elements. See under cells; 

columns; rows 
entering text into, 112, 113 
formatting", 118-1 9 
indenting, I 17 
modifying, 114-1 7 
navigating, 112, 113 
summing the columns, 119 

tables of contents, hyperlinks 
fo r, 47 

tabs 
in dialog boxes, 22 
for paragraphs in Word, 87 
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sheet tabs (Excel window), 
124, 132 

Template Wizard (Excel) 
installing, 175 
merging workbooks, 175 

templates, 26 
choosing, 26 
in Excel, 170-71 

creating new, 170 
customizing, 171 
default, 170, 1 71 
testing, 17 1 
versus macros, 171 

opening, 170 
organizing, 92 
in PowerPoint 

applying to presen tations, 
186 

creating presentations 
with, 186 

in Word, 81, 92-93 
applying to documents, 93 
creating documents 

with, 93 
saving documents as, 

92,93 
Templates folder, 93 
text 

adding borders to in Word 
documents, 120 

aligning, 84, 106 
animatin~8~21~213 
arranging in columns, 122 
colo ring, 82 
converting to Word tables, 

112 
copying, 28-29 

in Word documen ts, 68, 
72-73 

correcting grammar in Word 
documents, 76-77 

correcting spelling 
undoing/redoi ng 

corrections, 34 

while typing, 32, 76 
in Word documents, 

76-77 
cutting, 28 
deleting, 66 
editing, 28-29 

in Word documents, 63, 
67-79 

entering 
into Excel worksheet cells, 

126-27 
into Powerl'oint outlines, 

194 
into PowerPoin t place­

holders, 191, 192-93 
into Word documents, 66 
into Word tables, 112, 113 

find ing and replacing, 30-31 
in Word documents, 

74-75 
formatting 

in Excel worksheets, 146, 
147 

with find and replace, 31, 
74-75 

while typing, 83 
in Word documents, 66, 

74-75, 8 1-104 
inserting between words, 192 
moving, 28-29 

in Word documents, 68, 
72-73 

point sizes, 37 
restoring deleted, 71 
selecting, 71 
shading in Word documents, 

120 
See also labels; text boxes; text 

formatting; WordArt 
text alignment. See aligning, text 

in Word 
text annotations, adding to 

Excel charts, 155 
text boxes, in dialog boxes, 23 



text formatting 
applying effects, 83 
browsing in Word, 67 
finding and replacing, 31 

in Word, 74-75 
tex t labels. See labels 
thesaurus (in Word), 78 
35mm slides, creating, 231 
3-D effects, adding to 

objects, 39 
limes, inserting in Word, 108 
tips 

Office Assistant tips, 17 
ScreenTips, 24, 25 

Lillebars 
in Office program windows, 

64, 124, 187 
"[Shared]" status message, 

163, 173 
Title Master, versus Slide Maste r, 

198 
tilles, adding to Excel charts, 

154 
toolbar buttons, 64, 124, 187 

displaying names of, 24, 64 
See also specific too/bar 

buttons 
toolbars, 24-25, 187 

Alignment toolhar 
(Excel), 148 

flrowse toolbar (Word), 67 
customizing, 25 
docking, 24 
Drawing toolbar, 39 
Formatting toolbar, 24, 64, 

88,89, 106 
Header And Footer toolhar 

(Word), 107, 108 
hiding/displaying, 24, SO 
moving, 24 
Print Preview toolbar 

(Word), 79 
reshaping, 24 

Reviewing toolbar, 35 
Screen Tips on, 24, 25 
Shortcut Menus toolbar, 25 
Standard toolbar, 24, 64, 

110, 143 
Web toolbar, 45, SO 
WordArt toolbar, 41 

Track Changes feature (Excel), 
162-63 

tracked changes (in Excel 
worksheets) 

accepting/rejecting, 163 
viewing, 162 

tracking changes 
in Excel worksheets, 162-63 
in Word documents, 111 

transition effects. Sre slide 
transitions 

trend li nes, adding to Excel 
charts, 153 

typing errors 
deleting, 34 
See also spelling, correcting 

unde rlines, applying in 
Word, 82 

Undo button, 34, 71, 153 
undoing actions, 34, 71 
URis (uniform resource 

locators), 53 

Value Pack (Office 98), installing 
components from, 6-7 

view buttons 
PowerPoint window, 187 
Word window, 64, 65 

views 
changing, 65, 188 

in PowerPoint, 188-89 
in Word, 64 

Web 
creating documents for, 59, 

60-61 
getting information 

about, 15 
searching for information 

on, 56 
Web browsers, previewing Web 

pages in, 62 
Web documents, 45-62 

creating, 59, 60-61 
opening in Word, 53 
See also hyperlinked 

documents; Web 
pages 

Web Page Wizard, creating 
documents fo r the 
Web, 59 

Web pages 
addresses, 53 

finding, 62 
creating, 59, 60-61 
frames, 61 
opening in Word, 52 
previewing, 62 

Web toolbar, 45, SO 
buttons, 51, 56, 57, 58 
hiding/displaying, SO 

wildcards, as search characters, 
74, 75, 168 

wi ndows 
arranging, 18 
duplit"ating, 18 
moving, 18 
resizing, 18 
sizing boxes, 21 
splitting (in Word), 69 

See also document windows; 
program windows 

Windows Clipboard. See 
Clipboard 

wizards, 26 
AutoContent Wizard 

(PowerPoint), 59, 185 
Chart Wizard (Excel), 150-51 
creating documents with, 27 
Internet Assistant Wizard, 

60-61 
PivotTable Wizard (Excel), 

160 
Template Wizard (Excel), 

175 
Web Page Wizard, 59 

Word (Microsoft), 63-122 
opening Web documents/ 

pages in, 52, 53 
previewing Web pages in, 62 
print options, 70, 80 
program window. Sec Word 

win dow 
styles, 81, 95-97 
templates, 81, 92-93 
thesaums, 78 
See also Word documents 

Word documents, 63-122 
applying templates to, 93 
bookmarks, 47 
browsing, 67 
checking word usage, 78 
comments, 67, 110 
copying text between, 68, 73 
copying text in, 72-73 
correcting spelling/grammar, 

32, 34, 76-77 
creating, 63-80 

with Excel data, 228-27 
from presentations, 231 
from templates, 93 

creating slides from, 230-31 
desktop publishing effects, 

120-21 
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Word documents contimwd switching behveen, 68 selecting in Word, 71 entering text and numbers 
displaying in two panes, 69 tracking changes in, Ill wordwrap, in Word docu- into, 126-27 
editing, 63, 67-79 viewing all, 68 ments, 66 filling in data automatically, 
embedding Excel charts See also documents; main workbooks (in Excel), 123 144 

worksheets in, 229 documents (for mail consolidating data from, formatting text and 
enhancing, 1 05-22 merges); tables (in 174 numbers, 146-47 
entering/deleting text, 66 Word documents) copying worksheets to, 134, formulas. See formulas 
footers, 91, 106-7 Word window, 64, 66 135 functions, 143 
formatting text, 66, 74-75, elements, 64, 65, 67, 68, 69 making exclusive (removing inserting, 132, 133 

81-104 Word Art shared status), 163 inserting columns/rows into, 
going to specific locations, creating, 40-41 merging, 175 136 

72, 74 deleting, 41 navigating, 125 linki ng, 165, 176 
headers, 91, 1 06-7· WordArt (Microsoft), 40 opening, 171 moving, 134, 135 
highlighting changes in, 111 WordArt Alignment button sharing, 172-73 naming, 132, 133 
hyphenating, 78 (WordArt toolbar), 41 See also worksheets (in Excel) navigating, 125 
inserting Excel ranges into, WordArt Character Spacing worksheets (in Excel), 123-82 previewing, 138 

228 butto n (WordArt align ing data, 148 printing, 138-39, 149 
insertion point, 63, 66 toolbar), 41 auditing, 177 protecting/ un protccting, 
moving text between, 68, 73 WordArt Gallery button cells. See unda cells 164 
moving text in, 72-73 (WordArt too1bar), 41 consolidating data from, saving as HTML documents, 
navigating, 67 WordArt Same Letter Heights 174 60-61 
nonprinting characters, button (WordArt copying, 134, 135 scrolling, 125 

66, 87 toolbar), 41 creating, 123-44 selecting, 132 
opening new, 66 WordArt Shape button creating reports from, 179 switching, 125, 132 
page setup, 70 (WordArt toolbar), 41 creating Word documents tracking changes in, 162-63 
previewing, 70, 79 WordArt toolbar with data from, viewing, 178 
print options, 70, 80 buttons, 41 228-29 See also lists, in Excel 
printing, 80 displaying, 41 data analysis, 145, 156-64 World Wide Web. See Web 
saving WordArt Vertical button default number in work-

as HTML documents, 60 (WordArt toolbar), 41 books, 166 0 as templates, 92 words deleting, 132, 133 
selecting text in, 71 deleting, 34 designing, 145-55 

zoom box (windows), 1 8 shrinking to fit pages, 79 inserting text between, 192 embedding in Word 
summarizing, 111 red-lined, in Word, 76 documents, 229 
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